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Academic Courseware Exchange License Agreement 
Carefully read the following tenns and conditions of this 
agreement before using this package. Using this package 
indicates your acceptance of these tenns and conditions. If 
you do not agree to these tenns and conditions, promptly 
return the unused diskette and other components of the 
courseware package to the Kinko's store where you 
purchased them and your money will be refunded. No 
refunds will be given for courseware packages which have 
been used or are missing components. 

1. License. You have a non-exclusive and non­
transferable license to use the enclosed courseware program. 
You may use the courseware program on a single computer 
at a time. You may not use, copy, modify or transfer the 
courseware program or any of its related documentation, in 
whole or in part, except as expressly provided for in this 
license agreement 

2. Copyright. The courseware program and related 
documentation are copyrighted. You may not copy the 
courseware program or its documentation except that you 
may make one (1) copy of the courseware program for back­
up purposes. The back-up copy must display the copyright 
notice. All other copies are in violation of this license 
agreement 

3. Confidentiality. You may not sell, transfer, publish, 
disclose, display or otherwise make available any courseware 
program or copies thereof to others. The courseware 
program is a trade secret of Kinko's or of the parties under 
whose license Kinko's Service Corporation provides the 
courseware program. Violation of this provision shall be 
the basis for immediate tennination of this license. 
Tennination of this license shall be in addition to and not in 
lieu of any other legal or equitable remedies available to 
Kinko's Service Corporation. 

4. Term. This license shall be effective until tenninated. 
You may tenninate the license by destroying the courseware 
program and all related documentation. In addition, this 
license shall terminate for failure to comply with any term 
or condition of this license agreement In the event this 
license is tenninated by your failure to comply with this 
license agreement, you agree to destroy all copies of the 
courseware program and its related documentation. 

S. Limited Warranty. The courseware program is 
provided "as is" without warranty of any kind, either 
expressed or implied, including, but not limited to, the 
implied warranties of merchantability and fi1ness for a 
particular purpose. Should the courseware program prove 
defective, you (and not Kinko's service corporation or any 
Kinko's Service Corporation affiliate or distributers) assume 
the entire cost of all necessary servicing, repair or corre<:tion. 
Further, Kinko's Service Corporation, or any Kinko's 
Service Corporation affiliate or distributers does not warrant, 

guarantee or make any representations regarding your 
requirements or that the courseware program is free of errors. 

Kinko's Service Corporation does warrant to the original 
licensee that the diskette(s) on which the program is recorded 
to be free from defects in materials and workmanship under 
normal use for a period of ninety (90) days from the date of 
delivery as evidenced by a copy of your receipt 

Kinko's Service Corporation's entire liability and your 
exclusive remedy shall be a) the replacement of any 
diskette(s) not meeting the "Limited Warranty" specified in 
this license agreement and which is returned to Kinko's 
Service Corporation or any authorized Kinko's with a copy 
of your receipt, or b) if Kinko's Service Corporation or an 
authorized Kinko's is unable to deliver a replacement 
diskette(s) which is free of defects in materials or 
workmanship, you may tenninate this license and your 
money will be refunded. 

The above warranty is the only warranty of any kind. Some 
states do not allow the exclusion of implied warranties, so 
the above limitation or disclaimer may not apply to you. 
This warranty gives you specific legal rights and you may 
also have other rights which vary from State to state. 

Neither Kinko's Service Corporation nor anyone else who 
has been involved in the creation, production, or delivery of 
this courseware program shall be liable for any direct, 
indirect, consequential or incidental damages arising out of 
use or inability to use such courseware program even if 
Kinko's Service Corporation or any Kinko's affiliate has 
been advised of the possibility of such damages, or for any 
claim by any other party. 

6. ControUfog Law. This license ag.reement shall be 
governed by the laws of the State of California and shall 
inure to the benefit of Kinko's Service Corporation, its 
sucessors, administrators, heirs and assigns. 

7. Acknowledgment. You acknowledge that you have 
read this agreement, understand it, and agree to be bound by 
its tenns and conditions. You further agree that it is 
complete and exclusive statement of the agreement between 
the parties and supercedes all proposals and prior agreements, 
whether verbal or written, and any other communications 
between the parties relating to the subject matter of this 
license agreement 

Should you have any questions concerning this License 
Agreement, you may contact Kinko's Service Corporation 
by writing to: 

Kinko's Service Corporation 
Academic Courseware Exchange 

4141 State Street 
Santa Barbara. CA 93110 
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Drexel 
Plot 

A Graphing 
Package 

Drexel Plot is a software package designed 

specifically for graphing line graphs and scatter graphs. 

This package uses four menus: File, Edit, Data, and 

Graph . The File and Edit menus offer many common 

Macintosh File and Edit commands, as well as an "Open 

SYLK" and a "Copy Plot" command. The Data and 

Graph menus, however, offer specific graphing options 

with w hi ch you can: 

o enter as many as four sets of data, and place as 

many as four lines on the same graph 

o select your own range, increments, and axis 

origin for your grid 

o choose the decimal places for the numbers on 

your grid 



The Manual: 

The Tutorials: 

DP 2 

This manual may be used as a quick reference to Drexel Plot, or as an in-depth 

training guide to graphing with Drexel Plot. If you would like to learn basic 

graphing techniques using this application, you may want to work through the 

tutorials at the beginning of this manual. Each successive tutorial includes more 

advanced plotting techniques, so if you are truly a novice at graphing, you will 

probably want to begin with Tutorial #1. If you are quite familiar with graphing 

techniques, however, and need to know only the specific commands required to 

operate Drexel Plot, you can refer to the reference and glossary sections at the 

back of this manual. 

E ach tutorial contains a variety of procedures and instructional questions, as well 

as helpful tips and definitions for using Drexel Plot. To help you distinguish 

between these elements, they will be labeled throughout the tutorials as follows: 

1. 

? 
• 

numbers mark the guided procedures you will follow to use the 

Drexel Plot package 

indicates instructional questions 

indicates special reminders 

SMALL CAPS indicate words which are included in the glossary 

marks the upper right hand comer of every page of the reference 

and glossary sections 



Some General 
Principles of 
Graphing 

What is a graph? A graph is a visual representation of the relationship between two sets of numbers 
- that is, paired data It is composed of two main axes: 
one axis is a horizontal line called the x AXIS, 
and the other axis is a vertical line called the 

Y AXIS. 

... 
y 

a 
x 
i 
s • ~x axis • 

T hese axes are often placed on a GRID - a special format of evenly-spaced 
horizontal and vertical lines. 

A grid divides the X and Y axes into even intervals - in other words, it makes a 
SCALE along these axes. You can think of a scale in this instance, then, 
as a line which is divided into regular intervals 
- for example, 1...2 ... 3 ... , or 5 ... 10 ... 15 ... , 
etc. 

Scale 

DP3 



How do you 
graph data? 

DP4 

To prepare a scale along the X and Y axes, place one set of the numbers in your 
data set at regular intervals along the X axis, and the other set of numbers at 
regular intervals along the Y axis. The interval you choose for the X axis does not 
have to be equal to the interval you choose for the Y axis. For instance, you could 
have a graph that looks like this: 

h 15 
0 12 
u 

9 r 
s 6 

3 

1 3 5 7 days 

Figure Pl 

Notice also that the numbers along the X axis do not have to be in the same units 
(for example, degrees, days, hours, etc.) as the numbers along the Y axis. On the 
graph above, the X axis is divided into equal intervals and the Y axis is divided 
into equal intervals - but each axis is divided into different units. 

You can see, therefore, that there are three main rules to remember about a graph: 

1. each axis must be divided into regular intervals 

2. the interval you choose for the X axis may be different 
from the interval you choose for the Y axis. 

3. the intervals along one axis may be in different units from 
the intervals along the other axis. 

You're interested in making a graph so that you can see the relationship between 
two sets of numerical data - for instance, the average temperature for each month 
in a year. Now you know what a graph is, but~ do you actually graph data? 
First, you'll need to learn a few definitions: 

o To begin, you can call the collection of numbers chat you wane to place 
on your graph a DATA SET. 



o Within that data set are DATA PAIRS, or pairs of corresponding 
numbers. Using Figure Pl, for example, one corresponding pair might 
be the number of hours you worked during a certain day: let's say, 9 
hours on day 2. 

o The data from your data set which fall along the X axis are called the x 
COORDINATES and the data which fall along the Y axis are called the Y 

COORDINATES. 

o A data pair is usually represented like this: (2,9) or, (X coordinate, Y 
coordinate.) 

Now - to graph your data set, begin by creating a scale: determine a range of 
numbers that includes all the numbers in your data set, and then place those 
representative numbers at regular intervals along the X and Y axes. Next, look at 
your first data pair (X, Y), and detennine where those numbers will fall on their 
respective axes. Then, draw an imaginary vertical line from the X coordinate, and 
draw an imaginary horizontal line from the Y coordinate. The point at which these 
two lines meet is called an Th'TERSECTION. 

h 15 
0 12 Intersection 
u 

9 data pair (2, 9} 
r 
s 6 

3 

1 3 5 7 days 
Figure P2 

"Vhen you are graphing data on a grid, you must place a point (a dot or symbol) at 
the intersection of each corresponding set of numbers on the X and Y axes : this is 
called "plotting the points." Each of these points, then, represents one data pair -
or one X coordinate and the corresponding Y coordinate. After you have plotted 
all of your points and have drawn a line connecting them, you have created a 
graph. (Figure P3) 

OPS 



What is the Drexel 
Plot grid? 

P6 
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Figure P4 shows the Drexel Plot grid. Each element of this grid has been labeled 
to help you understand the various tenninology which is used throughout this 
manual. Each of these elements is defined in the glossary and in Tutorials #1 - #3. 
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Tutorial #1 

Graphing One Data Set 

you will learn ................. . 

o entering data 
o editing data 
o preparing the grid 



Tutorial #1 .~ 

Graphing 
One Data 
Set 

i 
I 
I 
1 
~ 

J 

I 
I 

I 
I 
I 
i.! Entering data J 

I 
I 

In this tutorial, you will be plotting the average monthly snowfall for Philadelphia, 
Pennsylvania. You will learn how to enter data, edit data, and prepare the grid lines. 

For this exercise, the list of snowfall accumulation and the list of months together are 
called a data set One part of the data set, in this case the months, will represent the X 
coordinates and will be plotted along the X ax.is: the other part of the data set, the 
snowfall, will represent the Y coordinates and will be plotted along the Y axis. 

Drexel Plot will accept only numerical data; therefore, if you have data which is not 
numerical you will have to convert it to numbers before you can enter it into the Drexel 
Plot data set window. 

1. Insert the Drexel Plot disk 
into your Macintosh. 

2. Click on the darkened Drexel 
Plot icon to open the Finder 
window. 

3. Now open the Drexel Plot 
application by clicking on the 
Drexel Plot icon. 

You should see the window labeled, "data set l." In this window, there is a table 
with two cloumns labeled, "X-Coord" and "Y-Coord." In the cells under these columns, you 
can enter the values contained in your data set- in other words, the pairs of numbers which 
you want to graph. 

l Here is the data set l for th~ tutoriat 

.~ 

January 
February 
March 
April 

Aye rai:e Snowfall <inches) 

5.3 
6.2 
3.7 
0.2 
0 

l 
l 

May 
June 
July 
August 
Seprember 
October 
November 
December 
January 

0 
0 
0 
0 
0 
0.7 
4.2 
5.3 

1 



2 

? 
• 

Remember: for this tutorial, the months data will be the X coordinates, and the 
snowfall data will be the Y coordinates. 

How do you plan to enter the "months" data in this table? 

On some graphs you could simply write the names of the months along the X 
axis: however, since Drexel Plot will accept only numerical data, you must 
choose numbers to represent the months. Begin with January as month # 1. 

4. Enter the first X coordinate 
in the first cell of the data set. 
Press RETURN. 

After you have typed a number into a cell, you can move to the next cell by pressing either the 
RETURN key or the ENTER key, or by clicking the mouse in the following cell. 

5. After you have entered all of 
your data, click in the circle 
labeled, "Use Data." 

This indicates that you want to graph the data. 

A few tips: 

Don't worry if you see your numbers "growing" after you press the RETUR.i'\l or 
ENTER key (for example, 5.300 instead of 5.3). This is due to the number of decimal 
places entered in the Decimal Digits cell of the ''Display Format" command in the Data 
menu. You will be able to adjust this number later. 

The square labeled, "Index Range" in the lower right hand corner of the Data Set 
window allows you to graph only a portion of the data which you have entered in the 
window. For example, if you wanted to graph only the snowfall data from February to 
April, or cells #2 - #4, you would enter the cell numbers "2" and "4" in the Index Range 

1 boxes. 



Editing data 

Preparing 
the grid 

? No one is a perfect typist How can you correct a mistake you have made while 
typing in your data? 

See the following instructions. 

1. Select the cell \\There you have 
made the error. 

2. Choose "Clear" from the Edit 
menu. 

3. Type in the corrected number. 

You can also edit a data set using the same editing techniques you would use with Mac Write or 
other Macintosh applications. However, in Drexel Plot you can change only one cell at a time 
- you wrull select and clear an entire group of cells at one time. 

*****Now you are ready to set up your grid.***** 

1. Select "Grid" from the Graph 
menu. 

In this box. you can set up the major elements of your grid: for example, the type of lines you 
want on the grid or the type of labels you want on the X and Y axes. 

2. In the column marked "Label" , 
click in the boxes labeled "ON" 
for the X and Y axes. 

Lah.el:. The label option lets you choose whether or not you want to label the increments of the 
X and Y axes with your numerical data. If the boxes marked "ON" are blank, then the label 
option is not active. For this tutorial, let's label both axes. 

3. Double click in the square 
labeled, "Decimal Digits" at 
the bottom of the Grid box, 
and type in the number "1." 

l..a12d.s (Decimal Digits): This option lets you choose the number of decunal places you went 

3 
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to represent with the labels on the grid. Whenever you choose to label your axes, you will also have to 
choose how many decimal places you would like to represent with the labels. You may choose to 

i . represent your decimal numbers either as fixed decimals or as floating decimals. Fixed decimals will have 
1 a finite number of decimal places, while floating decimals will be denoted by scientific notation - for 
·~ example, "le + O." 

l 
!*~ .. ,~ ? Why would you want to change the number of decimal places on the grid label? 

Look at the snowfall data: notice that any element in this data set has a maximum of 
one decimal place; therefore, to keep your graph from looking too cluttered, you ! may choose to display only one decimal place for the grid label. 

, 

4 . 

Remember: changing the decimal digits in the Grid window will change only the 
decimal digits on the grid - it will not change the decimal digits in the data set 
window. 

Now look in the section 
labeled, "Grid Type." 

This option lets you decide what kinds of lines you want to form your grid. You may choose 
any combination of lines and tick marks to make up your grid. Here is an example of a grid 
composed of lines and tick marks. (Fig. 1.0) 

Figur e 1.0 



s. 

6. 

Click in both circles 
la beled "line" for the 
major increments. 

Remember: the options you select in the Grid box will determine only the 
features of your grid - not of your graphed data. The Grid Type option, 
therefore, will set up the lines which actually f onn. the grid: it will not 
affect the lines which represent your plotted data points. 

Click in the circles 
labeled "tick" for the 
minor increments . 

. Since this graph is a simple graph, it is not necessary to have lines representing the 
minor intervals. It would be nice to know, however, exactly where the minor 
intervals do occur on the graph; therefore, you can mark these intervals with small 
"tick marks" along the axes. 

7. Click on "OK" in the Grid 
box, and then choose 
"Show Graph" from the 
Graph menu. 

6. 2 

5.6 

5 .0 

4.3 

3.7 

3.1 

2.5 

1.9 

1.2 

0 .6 

0 .0 

Your graph should look like this: (Figure 1.4) 
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8. 'Now save this graph 
and label it "SNOW." 

In this tutorial you have learned how to create a simple graph using Drexel Plot. Now 
you are ready to learn some more advanced graphing techniques. 



i 5. Click in both circles 
labeled "line" for the 
major increments. 

Remember: the options you select in the Grid box will detennine only the 
features of your grid - not of your graphed data. The Grid Type option, 
therefore, will set up the lines which actually form the grid: it will not 
affect the lines which represent your plotted data points. 

6. Click in the circles 
labeled "tick" for the 
minor increments. 

Since this graph is a simple graph, it is not necessary to have lines representing the 
minor intervals. It would be nice to know, however, exactly where the minor 
intervals do occur on the graph; therefore. you can mark these intervals with small 
"tick marks" along the axes. 

7. Click on "OK" in the Grid 
box, and then choose 
"Show Graph" from the 
Graph menu. 

Your graph should look like this: (Figure 1.4) 
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8. 'Now save th is graph 
and label it "SNOW." 

In this tutorial you have learned how to create a simple graph using Drexel Plot Now 
you are ready to learn some more advanced graphing techniques. 



Tutorial #2 

Adding More Data to Your Graph 

you will learn ................. . 

o adjusting decimal places 
in a data set 

o choosing line types 



Tutorial #2 

Adding More 
Data to Your 
Graph 

"Vith the graph you made in Tutorial #1, you can determine the average snow 
accumulation for any one month of a year. If you follow the plotted line on the graph, 
you will see that there was no snow at all during months, #5 - #10 (May - October), and 
that the greatest accumulation occurred during month #2 (February). In this tutorial, 
you will add some rainfall data to the snow accumulation graph, and you will learn how 
to adjust the graph to accommodate both data sets. Specifically, you will learn to adjust 
the decimal places in a data set window, and to choose line types for your plotted data. 
Once you have graphed your data, you will be able to see the average rainfall 
accumulation for each month. By combining this graph with the graph from Tutorial 
#1, you will also be able to compare the average snowfall and the average rainfall for 
each month. 

This is Data Set IT: Month 

January 
February 
March 
April 

Avera~e Rainfall Ci nches) 

? 
• 

May 
June 
July 
August 
September 
October 
November 
December 
January 

3.16 
3.11 
3.52 
3.29 
3.34 
3.65 
4.10 
4.50 
3.41 
2.79 
3.10 
3.21 
3.16 

Do you see any difference between this rainfall data and the snowfall data from 
Tutorial #1? 

The rainfall data is represented with two decimal places, and the snowfall data 
is represented with only one decimal place. 

1. Open the file you saved 
from tutorial #1. 

7 



Adjusting 
decimal 
places in the 
Data Set 
window 

8 

2. Choose, "Show Data Set 
II" from the Data menu 
and enter the rainfall and 
months data. 

Again, the months will represent the X coordinates and rainfall will represent the Y 
coordinates. (See the instructions in Tutorial #1 if you have trouble with this step). 

I~ 3. Now, click on the option, 
" Use Data." 

:~ 

l~ 

I 
~ 

I 

'\iVhen you enter your data into Data Set II, you may notice that the numbers in the 
"X-Coord" and "Y-Coord" columns will not be entered with two decimal places, but 
instead will be automatically increased to three decimal places. How can you adjust the 
numbers in the Data Set window so they will have only two decimal places? 

1. Choose "Display Format" 
from the Data menu. 

2. Double click on the box 
labeled "Decimal Digits" , 
and enter the number "2." 
(Be sure the button 
labeled, "Fixed Decimal" 
is also darkened). 

3. Now click on " OK", and 
return to the Data Set II 
window. 

You will see that all of your numerals in both Data Set I and Data Set Il are now represented 
with two decimal places. 

Remember: use the "Display Format" command whenever you wish to adjust 
the number of decimal places in your Data Set windows. 



Choosing 
line types 

*****Now you should choose a different line to represent each data set.***** 

? 
• How can you tell which line on your graph represents snowfall, and which 

line represents rainfall? 

You will have to distinguish these two lines with different symbols or by 
different line thicknesses. 

1. Select "Line Controls" 
from the Graph menu. 

In this window, you may choose different lines and symbols to represent your data. This is 
especially helpful if you are graphing more than one set of data on one graph. 

2. Click in the circle 
marked, "Data Set I", 
then choose a thick line 
with no symbols to 
represent your first data 
set. 

Drexel Plot will automatically save the line control options you entered for Data Set I. 

3. Now click in the circle 
labeled, "Data Set II" and 
choose a thin line with the 
"*" character. 

For future graphs, you can use any symbol on the Macintosh keyboard. 

4. Click on "0 K" to close 
the Line Type window, 
and then choose "Show 
Graph" from the Graph 
menu. 

Your graph should look like this: (Fig. 2.0) 

9 



10 

6.2 

5.6 

5.0 

4.3 

3 .7 

3.1 

2.5 

1.9 

1.2 

0 . 6 

0 .0 

-

~ 
~l 

' ' _..:I.__ 

.-- " 
\ 
1 

----· ~ 

' ' L_ 

~ 

~ I 
~ ... ~ A,. 

~ JI 
~ I 

I 
I 

_I 

""" 1.2 2 .4 3 . 6 4 .8 6 .0 7.2 8 . 4 9.6 10 . 8 12.0 

S. Save this graph using the 
"Save" command in the 
File menu. 

You will use this graph for Tutorial #5. 

Figure 2.0 

In this tutorial, you learned how to graph two data sets. Next, you will learn how to 
custom design the elements of your grid and graph. 



Tutorial #3 

Using Automatic and Manual Scaling 

you will learn ................. . 

0 using Automatic Scaling 

0 using Manual Scaling 

0 adjusting the range of the 
grid scale 

0 adjusting the increments 
of the grid scale 

0 adjusting the axis origin 



Tutorial #3 

Using 
Automatic 
and Manual 
Scaling 

Using 
Automatic 
Scaling 

In Tutorials #1 and #2, Drexel Plot automatically set a scale on your grid according to 
the numbers you entered in your data set. For some graphs, you may prefer this 
AUTOMATIC SCALING function. But suppose you wanted a grid scale that included a 
range of data larger than the range covered by your data set? Or, suppose you wanted to 
change the increments on the scale? Drexel Plot has another option which lets you 
adjust these elements - MANUAL SCALING. Try entering the following temperature 
data into a data set, and graphing it using automatic scaling. You will have to create a 
new file for this exercise. 

1. First, create a new Drexel 
Plot file by choosing 
"New" from the File 
menu. 

2. Now enter the following 
data into Data Set I and 
click on "Use Data." 

Data Set I Month 

January 
February 
March 
April 
May 
June 
July 
August 
September 
October 
November 
December 
January 

3. After you have entered 
this data, choose "Grid" 
from the Graph menu 
and enter the number 
"l" in the box labeled, 
"decimal digits." 

Avera::e Temperature f°F) 

33.1 
33.8 
41.6 
52.2 
63.0 
71.8 
76.6 
74.7 
68.4 
57.5 
46.2 
36.2 
33.1 

11 



Using Manual 
Scaling 
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4. Now click on "OK" and 
choose "Show Graph " 
from the Graph menu. 

Did you remember to "Use Data"? 

Your graph should look like this: (Fig. 3.0) 
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Figure 3.0 

Although Figure 3.0 is an accurate graph of the temperature data, you may wish 
to adjust the scale of the X and Y axes to include a wider range of temperatures 
- for instance, -2°F or 105°F. In addition,you may want to place a more 
standard increment along your axes: for example, 5°F or 10°F along the Y axis, 
and 1 (month) along the X axis. To change the increments and the labels on your 
graph, you can use the Drexel Plot scaling option, "Manual Scaling." 

1. Choose "Scaling" from 
the Graph menu. 

The circle labeled, "Automatic Scaling" is darkened: when you choose this option, 
Drexel Plot will create a grid of 10 horizontal and 10 vertical lines, and will create a 
scale along each axis by dividing your range of data equally among the ten lines (see 
Fig. 3.0). If you choose "Manual Scaling", you will be able to design your own grid 
range and scale. 



Adjusting the 
Grid Range: 

1 . Select the option labeled, 
"Manual Scaling" in 
the "Scaling" box. 

Notice that four squares are provided for you to adjust the range of your grid: a low and high 
value for the X axis, and a low and a high value for the Y axis. You will also see that the range 
for the X values (months) does not need to be adjusted for this particular graph. 

2. Double click in the first 
square in the Y range. 

Since you are preparing a graph of temperature data, you will want the scale on the grid to 
include a wide range of real temperatures. For this graph, try a temperature range of 30°F to 
90°F: 

3. Type in the number,"30." 

4. Press RETURN. 

S. Now enter 1190" in the 
remaining box for the Y 
axis. 

6. Click on 11 OK.11 

Your graph should look like this: (Fig. 3.1) 
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adjusting grid 
increments on 
the Y axis 
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The graph in Figure 3.1 still doesn't look quite right. For one thing, the scale along the 
Y axis is still in increments of 4.3 units; therefore, the graph looks too crowded. Even 
worse, the axis origin is in the wrong place - about (1 ,33). You will be able to change 
the axis origin in the last section of this tutorial. For now, concentrate on changing the 
grid increments. 

1. Choose "Grid" from the 
Graph menu. 

2. 

When you are choosing the incrementS for your grid, it is irnponant to consider the range of 
your data. For example, data such as temperatures can range anywhere from below 0°F to 
above 90°F. With this wide range of data, you cannot possibly use an increment of l °F on 
your grid. For the data in this tutorial, it is logical to pick a Major Increment of 5°F, and a 
Minor Increment of 2.5°F, for the Y axis. 

Remember: the increments on the X and Y axes must be in regular, repeating 
intervals. 

Enter the Major and Minor 
Increments for the Y axis 
in the appropriate squares 
of the Grid box. 

Remember: eaclz axis will have both Major and N1inor Increments: at this 
moment, we are setting only the Major and Minor Increments for the Y axis. 



adjusting grid 
increments on 
the X axis 

*****Here's a little help to get you started:***** 

i. Double click in the "Y" square of the row labeled, 
Major Increment. 

ii. Type in the number, 11 5." 

iii. Press RETURN two times to get to the box labeled 
"Minor Increment" for the Y axis. 

iv. Now type in the number, 11 2.5.11 

If you look at the data representing the X coordinates (months), you will notice that it 
has a small range (1 - 13) and occurs in regular increments (units of 1 month). 
Therefore, you can use an interval of" l" for the Major Increments on the X axis of your 
graph, and an interval of 0.5 for the Minor Increments. 

1. Enter the appropriate 
values for the Major and 
Minor Increments of the 
X axis. 

2. Click on "OK." 

Your graph should look like this: (Fig. 3.2) 
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Axis Origin 
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Your graph is beginning to look a little better, but you still must adjust the axis origin. 
When you use Automatic Scalin~, Drexel Plot will set the axis origin at the lowest X 
coordinate and the Y coordinate of your data set . 

. For example, if you use Automatic Scaling to plot data which ranges from -4.0 to 4.0 on 
each axis, your graph would look like this: 
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With Manual Scaling, however, you could choose your own axis origin. If we set the 
axis orign at (0,0) for this same set of data, your graph would look like this: 
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Since we have already chosen a range of 1 - 13 for the X axis, and a range of 30°F - 90°F 
for the Y axis (see pp. 12 - 13), a logical place to put the axis origin for the temperature 
graph in this tutorial is at (1,30). So ..... 

1. Choose "Scaling" from 
the Graph menu. 



2. Double click in the axis 
origin square for the Y 
axis. 

The origin for the X axis is already set at "1" by Automatic Scaling, so you won't need to adjust 
this number. 

3. Now, type in the number, 
11 30" , and click "0 K.11 

Your graph should look like this: (Fig. 3.3) 
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You have seen that you can adjust the axis origin and the scale of your grid with Drexel 
Plot's Manual Scaling option. Once you've made these adjustments,.however, j'.QJ.! 
cannot return to the Automatic Scalin~ option without losine all of the chanees you made 
with Manual Scaline. But remember that you do not have to change every available 
option with Manual Scaling. In some instances, you might want to change only one 
element of your grid - for example, the scale. In these cases, you should use Automatic 
Scaling to prepare your grid, and then use Manual Scaling to make your changes. 

Through Tutorials #1 - #3, you have learned almost everything you will need to know to 
graph data using Drexel Plot: entering data, setting up your graph, and adjusting your 
graph to fit your data. The next two tutorials will cover extra information: how to plot 
Multiplan SYLK files, how to use the "Copy Plot" option in the Edit menu, and how to 
use Drexel Plot's special 'zoom' function. 
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Tutorial #4 

Graphing a Multiplan SYLK File 

you will learn ................. . 

o opening a SYLK file in 
Drexel Plot 

o entering SYLK file data 
into a Drexel Plot data 
set 



Tutorial #4 

Graphing a 
Multiplan 
SYLK File 

A Multiplan SYLK (Symbolic Link) Fll.E is a special data format for a Multiplan 
spreadsheet which can be easily transferred to another computer or Macintosh 
application. If you have a collection of data entered in a Multiplan spreadsheet which 
you would like to graph with Drexel Plot, you must save the document as a SYLK file, 
using the "Save As" command in the File menu of the Multiplan application. You may 
then transfer all or part of that file to a Drexel Plot diskette. 

You will see a Multi plan document on the Finder of your Drexel Plot diskette. This 
document is a Multiplan SYLK file of the average monthly temperature in Philadelphia, 
Pennsylvania. 

~ m 
avg. temp. 

This is how the SYLK file appears in a Multi.plan document: (Fig. 4.0) 

::::::-:·.:::·.:::·.:::·.:::·.:::·.:::·.::: ....... ~:::·.:::·.:::·.:::·.:::·.:::·.:::·.:::·.:::·~·.:::·.:::·.:::·.:::·.:::·.:::·.:::·.:::·.::~::·;;.·.::.".:::"~:::::: 

:::::: 1 1 : 33 . 1 ~y VALUE - ~~·~RAGE ••• • ....... •••••••••• ••••••••••••••••••• 1 •• 
.;:.. 2 2 ; 33 . 8 I TEMPERATURE 
..... • •••••••••••••••••••••••••••••••••••• 1 •••••••••••••••• h·.·. 
·:·.- 3 3 : 41 6 I ::·.':: 
:::::: 4 ....... "i ......... ~ ..... iii·:.:£ ..... · 1 · .............. : :::::::::::::: 
·· .. ·. . ...... ·5 ......... : ...... ·5 3 ....... · 1 · .............. ·#.:::·.::. 

~ ; ::::::::r:::::::.:::::tff ::::1:: ::::::~.::::'it~ 
::.-:. . ................. : ................. · 1 · ......... : ,. .... ·::·::.-::·::.-::·::.-::-
.... 8 a:.·~:.:: ..... :.. 7 4 . 7 I 4! .-; . .-: . .-:.::·::· 

::::::::::::~{~'·:~·~~.trti~t0:::::::::g:{::::::::::::::::::::: 
MONTHS Figure 4.0 

Remember: you can create a SYLK file only by using the "Save As" command 
in the File menu of the Multiplan application, and then clicking on the button 
labeled, "SYLK." 
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Opening a 
SYLK fi le in 
Drexel Plot 
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? A Multiplan document will accept text as well as numerical data; so, why are 
the months in Figure 4.0 represented by numbers? 

Although the Multiplan application accepts text and numerical data, the Drexel 
Plot application does not If you want to transfer a Multi plan SYLK file to 
Drexel Plot, therefore, all of your data in the SYLK file must be entered as 
numbers. You may still have text headings in the SYLK file as long as they 
are not a part of the data which you intend to graph. 

1. Open the Drexel Plot 
application by clicking on 
the Drexel Plot icon and 
choosing "Open" from the 
File menu. 

2. Choose " Open SYLK" 
from the File menu. 

After you have chosen the "Open SYLK" option, a list of all the SYLK files on your diskette 
will appear on your screen. There should be only one SYLK file in this list on a new Drexel 
Plot diskette. 

3 . Open the file, "avg. 
temp." . 

You will see a "SYLK Settings" box: (Fig. 4.1) 

Sylk Settings 

Load Into Dato Set ._I 1 _ ___, 

Get H ualues from Column # LJ 
Get Y ualues from Column # EJ 

( OK ) 

(Cancel J 

Figure ~.1 



Entering 
SYLK file 
data into a 
Drexel Plot 
data set 

1 You must enter three values in the SYLK Settings box: 

o the number of the data set in which you want to enter 
your data. 

o the column number of the SYLK file which contains the 
values representing the X coordinates 

o the column number of the SYLK file which contains the 
values representing the Y coordinates 

1. Enter the appropriate 
numbers for each of the 
SYLK settings (data set #, 
X-Coord, Y -Coord) and 

? • 

click on the "0 K" button. 
(See Fig. 4.0 for appropriate 

values.) 

After you click "OK", the diskette will 'read' your SYLK file and will automatically enter the 
spreadsheet values into the data seL 

Will your data be plotted automatically on the Drexel Plot grid? 

No - Drexel Plot cannot use the data you have entered until you have chosen 
the "Use Data" option in the Data Set box. 

2 . Choose "Show Data 
Set I" from the 
Data menu. 

3. Click on "Use Data," then 
choose "Show Graph" 
from the Graph menu. 

You have now graphed a Multiplan SYLK file with Drexel Plot.: the graph should look like 
this: (Fig. 4.2) 
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In this tutorial you graphed a Multi plan SYLK file. If you wish, you may use Manual 
Scaling to modify the range, major and minor increments, and axis origin of your graph. 

Now let's look at some additional features of Drexel Plot 



Tutorial #5 

Additional Features 

you will learn ................. . 

o using the "Copy Plot" 
command 

o pasting a Drexel Plot grid 
into MacPaint 

o using the 'zoom' feature 



Tutorial #5 

Additional 
Features 

Using "Copy 
Plot" 

Drexel Plot offers two features which enable you to easily manipulate a Drexel Plot 
graph: the "Copy Plot" command, and the 'zoom' function. You can use the "Copy 
Plot" command to copy a Drexel Plot graph, and then paste that graph into another 
Macintosh application. You can use the 'zoom' function to magnify certain portions of 
your graph. Each feature is discussed below. 

You can add text and graphics to your Drexel Plot graph by pasting it into MacDraw. 
Suppose, for example, you wanted to write the names of the months along the X axis of 
the rainfall/snowfall graph you created in Tutorial #2? Using MacDraw, you can add 
these names, as well as any other additional graphics: 

1. Open the Drexel Plot 
document which you 
saved from Tutorial #2. 

2. Choose "Show Graph" 
from the Graph menu. 

3. Now, select "Copy Plot" 
from the Edit menu. 

When you choose this option, Drexel Plot will place a copy of your grapQ. into the Macintosh 
Clipboard (see the Macintosh User's Guide if you do not understand the Clipboard). 

4. Quit Drexel Plot. 

5. Eject the Drexel Plot 
disk, but do not turn 
off the Macintosh. 

If you turn off the Macintosh after you have ejected the diskette, you will erase the 
contents of the Clipboard. 
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Pasting a 
Drexel Plot 
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MacPaint 
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I 6. Insert MacDraw into your 
Macintosh. 

If you are working with only one disk drive, the Macincosh will ask you to 'swap disks' several 
times. 

7. Click on the MacDraw icon 
and choose "Open" from 
the File menu. 

Now you will see a blank MacDraw screen. 

8. Choose "Paste" from the 
Edit menu. 

Your Drexel Plot graph will automatically be transferred from the Clipboard to the Macintosh 
screen. Now your graph has become a MacDraw document, and can be edited as you wish. 

You can also add text and graphics to your Drexel Plot graph by pasting the graph into 
MacPaint Because the MacPaint screen is smaller than the Drexel Plot screen, however, 
you will not be able to use the "Copy Plot" command to paste a Drexel Plot grid into 
MacPaint - a portion of the graph will be cut off in the MacPaint application. You can, 
however, paste a Drexel Plot grid into MacPaint using the Macintosh 'screen dump' 
technique. 

1. Open the Drexel Plot 
document which you saved 
from Tutorial #2. 

2. Choose "Show Graph" 
from the Graph menu. 

3. Now, press and hold all 
of these keys at the same 
time: SHIFT, COMMAND, 3. 

When you press this combination of keys, you will automatically create a MacPaint document 
of your graph. 

4. Close your Drexel Plot document, 
and return to the Finder. 

Do you see the icon of the new MacPaint document? D 
Screen 0 



Using the 
' zoom ' 
featu re 

! 5 . Copy the MacPaint icon 
onto a disk which contains 
a MacPaint application. 

Your Drexel Plot graph is now a MacPaint document, but it is also still saved as a Drexel Plot 
application. Using the SHIFT - COMMAND - 3 sequence, you can automatically create a 
MacPaint document of a Drexel Plot graph, or any other Macintosh application. 

If you have created an especially complex graph, you might want to enlarge one ponion 
of it in order to see the plotted points more clearly. You can use Drexel Plot's 'zoom' 
function to do this. 

1 . Open the Drexel Plot 
document which you 
saved from Tutorial #2. 

2 . Choose "Show Graph" 
from the Graph menu. 

Determine the area of your graph which you want to enlarge. 

3. Place the pointer (arrow) 
in the upper left corner 
of the area which you 
plan to enlarge. 

4. Hold down the mouse button 
and drag the mouse 
diagonally to the bottom 
right corner of the area 
you're enlarging. 

Drexel Plot will automtically switch your graph to the Manual Scaling mode, and will enlarge 
the particular area of your graph. 

5 . Now select "Scaling" from 
the Graph menu, choose 
the Automatic Scaling mode, 
and click "OK." 

You will see that the enlarged ponion of your graph has returned to itS original size. 
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You can use the "Copy Plot" command to copy a 'zoomed' graph into MacPaint 
(remember- it will cut off some of the graph) or Mac Write. This command does not 
work as well with the MacDraw application, however, because the 'zoomed' graph will 
copy into MacDraw along with some extraneous material. 

!! :::Kx&.~.:..~~ ........ J :: : :::sau:~~sornnm::mm:3;ss;;::· mmm:;;;; 

Now you have completed five tutorials which will help you to use the Drexel Plot 
graphing package. Remember - you can always refer to the reference and glossary 
sections for additional help while you're using Drexel Plot. 



A Drexel Plot Reference and Glossary 



A Drexel Plot Reference 

In this menu ... select. .. to ... using ... 

File "Open Sylk" open a Multiplan Sy lk 
file within Drexel Plot 
and enter the numerals 
contained in the 
Multi.plan cells into a 
Drexel Plot data set 

"Print" print a plot. Use 
standard or high quality 
only. 

Edit "Copy Plot" copy a Drexel Plot graph 
into other Macintosh 
applications such as 
MacDraw and Mac Write. 

Data "Show Data Set f' enter your data into the 
data table. You may 
enter up to 255 pairs of 
data (X and Y 
coordinates) in each data 
window. 

index range - graph only a 
certain portion of your entered 
data. For example, to graph 
data pairs #2 through #4, enter 
the numbers, "2" and "4" in 
the Index Range boxes at the 
bottom of the Data Set box. 

use data - graph your data. 
If you do not click on this 
option, your data will be 
entered in the data set, but it 
will not be graphed on the 
grid. 

enter additional data sets 
Show Data Set II'' as you did with your 
(also ill and IV) first data set 

set the desired number of 
"Display Format" decimal places in the d.fila 

set box. 
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In this menu ... se lec t ... 

Graph "Show Graph" 

"Scaling" 

"Grid" 

2 7 

to ... 

see your lines graphed 
according to the data 
which you entered and 
selected in the data set 
boxes. 

adjust your graph to the 
desired range, axis 
origin, data set, and 
scaling options. 

adjust the increments on 
the X and Y axes; choose 
between labeled and non­
labeled axes; choose the 
number and type of 
decimal digits you wish 
to represent on the ax.is 
labels; and choose the 
type of line you wish to 
have on your grid. 

u si n g ... 

automatic scaling- have 
the grid range, grid 
increments, and axis origin 
automatically set according to 
your data set. 

manual scaling- retain the 
option of setting your own 
grid range, grid increments, 
and axis origin. This option is 
helpful when your data covers 
a particularly wide range. 

range-- set your maximum 
and minimum X and Y 
coordinates. This option will 
operate only with "Manual 
Scaling." 

axis origin- adjust the X 
and Y axes to any midpoint 
position to accomodate both 
positive and negative data 
points. This option will 
operate only with "Manual 
Scaling." 



automatic scaling 

axis origin 

data pair 

data set 

fixed decimal 

floating decimal 

graph 

grid 

intersection 

major increment 

manual scaling 

minor increment 

range 
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A Drexel Plot Glossary 

an option provided by Drexel Plot which automatically sets the 
range, and major and minor increments of your graph based upon 
the numbers you enter in the data set 

the point on a graph where the X axis and the Y axis intersect. 

the corresponding X and Y coordinates of a data set. 

a group of data pairs which you wish to graph. 

a number having a finite number of decimal places represented 
along the axis of a graph. 

a number along the X and Y axes in which the decimal places are 
represented by scientific notation (base 10). 

a visual representation of the relationship between two sets of 
numbers. 

a series of regularly - spaced horizontal and vertical lines on which 
you construct your graph. 

the point on a graph at which an imaginary line drawn vertically 
from the X axis crosses an imaginary line drawn horizontally from 
the Y axis. 

the largest regularly repeating interval along the X and Y axes 
which creates a series of regularly repeating divisions along the 
axes. 

an option provided by Drexel Plot which allows you to set your 
own range, and major and minor increments of your graph. 

a regularly repeating interval along the X and Y axis which is 
one-half the length of a major increment. 

the totality of points included in a data set 



scale 

SYLK file 

tick mark 

X axis 

X coordinate 

Y axis 

Y coordinate 

a series of numbers, placed at regular intervals along the X and/or 
Y ax.es of your graph, which represents the total set of X 
coordinates and/or Y coordinates of your data set. 

a special data format for a Multiplan spreadsheet which you can 
transfer to another Macintosh application. 

a small slash which marks the position of the major and/or minor 
increments along the X and Y axes . 

the main horizontal line of a graph where the scale for the X values 
is placed. 

the X value of a data pair which is located on the scale along the X 
axis. 

the main vertical line of a graph where the scale for the Y values is 
placed. 

the Y value of a data pair which is located on the scale along the Y 
axis. 
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